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Getting started...

Thank you very much for your purchase of this Stereoscopic 3D paint program "StPaint Plus". 
StPaint Plus is a program that allows you to convert your ordinary 2D pictures to Stereoscopic 3D pictures
by means of depth painting.

In this package are contained the following items.

1) StPaint Plus Setup CD-ROM - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -1
In this CD-ROM are contained the following files.

• StPaint Plus Setup.exe: This is a Setup program of the StPaint Plus

• StPaint Plus User'sManual.pdf: This is the PDF file of this manual.

• Sample Image Folder

2) User"s Guide  - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -1
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Request for user's registration

User's registration is highly requested so that we may provide you with necessary information on this prod-
uct.

Execute the StPaint Plus and select "User Registration" from the "Help" menu to make the User
Registration.

There are 3 options for the User Registration.
1) Online registration: Our web-page for the User registration will be automatically opened.

2) Registration by Fax: Registration form by Fax will be opened. Print and fill the form and send it back to
Texnai, Inc.

3) Registration by e-mail: You can make the User Registration by e-mail from here.
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1-1: What is StPaint Plus ?

StPaint Plus is an application program that allows you to convert your ordinary 2D pictures to
Stereoscopic 3D pictures by means of what we call "Depth Painting".  In order to realize as
smoother 3D conversion as possible, in this program are prepared various kinds of Depth Pen and
Painting Mode such as Round Brush, Air Brush, Rectangular Paint, Elliptic Paint, Polygon Paint,
and Gradation Paint. Automatic conversions using the value of Brightness and Red or Blue color
are also included to give the special effect.

1-2: Major Functions of StPaint Plus

■ Read image files such as JPEG, TIFF, BMP. (Max. about 160MB or Exp. 7500x7500 pixels.)

■ Automatic 2D/3D conversion by using the value of Brightness and Red and Blue Colors.

■ Various kinds of Depth Pen.

■ Various kinds of Pen Shapes such as Round, Rectangular, Polygon, Gradation.

■ Real-time 3D display with Depth Paint such as Anaglyph, H-Interleaved 3D LCD, V-
Interleaved 3D LCD.

■ Print in various kinds of 3D format  such as Anaglyph, Parallel3Dview, Cross3D View.

■ Import/Export depth file (0-255 gradations).

Chapter 1: StPaint Plus Overview
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Chapter 2: System Configuration for StPaint Plus

2-1: System configuration recommended

The following system configuration is recommended to use the St Paint properly.

1) CPU: Intel or its compatible CPU, faster better.
2) OS: Microsoft Windows 2000, XP, Vista, 7
3) RAM: 128-Mbyte or more
4) Hard disk
5) Display: True Color, 1024x768pixel or more

[Note]: Painting image size depends on the hard disk volume size.

2-2: Available 3D display 

• Naked eye V-Interleaved G-Shift 3D LCD: Sharp 3D Mebius PC PC-RD3D 
• H-Interleaved 3D LCD: Zalman 3D Monitors, Hyundai / Miracube / JVC Xpol Monitors.
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3-1: How to set-up StPaint Plus

1) Execute "StPaint Plus Setup.exe" that is contained in the Setup CD-ROM as shown below.

2) English or Japanese can be used in this program, but in case you use any other system than Japanese,
"English" is automatically selected in the language selection dialog.  Select "O.K." 

3) The following dialog appears . Select "Next" to proceed this StPaint Plus installation.

Chapter 3: Installation of StPaint Plus
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4) When selecting "Next" appears the License Agreement Dialog as shown below. Read it carefully and
select "Next" when you agree.

5) When selecting "Next" appears Start Menu Folder Selection Dialog as shown below. Select "Next"
when it is confirmed.

6) When selecting "Next" appears Additional Task Selection Dialog as shown below. Select "Next" when
it is confirmed.
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7) Now you are ready to start installing the StPaint Plusin your system and the Installation Dialog appears
as shown below. Select "Install" to start installation.

8) When stating the Installation appears a progress bar as shown below. Wait until the Installation is com-
pleted.

9) When the Installation is completed appears a Information Dialog as shown below. Read it and select
"Next" when it is confirmed.
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10) When selecting the "Next" appears a dialog shown below. Select "Finish" to quit this setup program.

11) When selecting both "Launch StPaint Plus" and "Finish" launches the StPaint Plus and appears the
Personalization dialog as shown below.   

3-2: Launching StPaint Plus and the personalization

Launch StPaint Plus from the Start Menu or double click the Shortcut Icon on the Desktop to execute the
StPaint Plus.

* The Shortcut Icon of StPaint
Plus created on the Desktop
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When launching the program for the first time appears a Dialog Box as shown below for your User
Registration. Fill your name and organization, serial number of the program to make the User Registration. 

When completed the User Registration properly appears the Application Windows of StPaint Plus in
which you can execute the 3D Depth Paint.
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4-1: Stereoscopic 3D image

The StPaint Plus is a program that allows you to give Depth to an ordinary 2D image. Once a 2D image
gets Depth, it becomes a 3-dimentional object and we become able to render the multiple view images that
is viewed from different view-points. In case of StPaint Plus, a simple Ray Tracing program is always run-
ning behind and when giving a certain Depth to a 2D image, two different images that can be seen from
Right and Left eyes are rendered to create the Side-by-Side 3D image in real time. In this manual, we call
the image with Depth "Stereoscopic3D Image". 

Chapter 4: Basic knowledge and operation of the StPaint Plus

Original 2D image Image with Depth

3D converted image
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4-2: Basic Operations

Painting Window:
Your Depth Painting can be executed in this Painting Windows. You can open and paint here multiple
images at the same time.

[Note]: Available image size depends on the volume size of your hard disk. Prepare as much
volume as possible to paint large sized images. Available image size also depends on
the CPU power of your system. In case you use that of 3 GHz, available image size is
about 3K x 2K pixels. 

View Switchers:
You can switch Display Mode of the painting Windows by these buttons such as Left Image, Right
Image, Image in Stereo, Depth Paint. Detail will be shown later.

Painting Tools and Painting Modes:
A couple of painting tools and painting modes are prepared here to execute your Depth Paint. Detail
will be shown later.

* New Creation Icon of the Tool Bar

[ View
Switchers ]

[ Painting
Tools ]

[ Paining Window ]

When selecting "New" from the File Menu or "New Creation Icon" of the Tool
Bar appears the File Open Dialog. Select and open an image file as shown below
to execute Depth Paint. 

[ Application Window ]

[ Tool Bar ]

[ Painting
Modes ]
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4-3: View Switchers

StPaint Plus allows you to select 5 different view of the currently Painting Image by these View Switching
Buttons such as the Image viewed from Left Eye, the Image viewed from Right Eye, the Image viewed
from the Front, Depth in Red and Blue colors, and the Image in Stereo. You can paint at any view mode.

Is the difference in the picture of the left and right known?

In the Depth mode, each depth is expressed by
the value of Blue and Red colors. Roughly say-
ing, the background is bluer and the foreground
is redder.

StPaint Plus allows you to select a couple of dif-
ferent Stereoscopic Display from the Stereo
Mode Selection of the File Menu such as
Anaglyph, H-Interleaved 3D LCD, V-Interleaved
G-Shift 3D LCD. When selecting the Stereo
Mode for the Painting Image, you can see the
Painting Image in the currently selected stereo
mode. Details will be shown later.
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4-4: Depth Painting

Operation of the Depth Paint is almost similar to ordinary paint program except the difference of Depth
and Colors. Ordinary paint program allows you to paint Colors and Shapes using various kinds of color
pens. StPaint Plus allows you to paint Depth and Shapes using various kinds of Depth Painting Tools.
Actually you can paint the Depth by selecting a necessary combination of Depth Painting Tools and
Painting Mode as shown below.

4-4-1: Depth Painting Tools

In this StPaint Plus are prepared 3 kinds of Depth Pens that include Round Brush, Air Brush1, Air Brush2
and 3 kinds of Painting Shapes that include Rectangular, Ellipse, Polygon to execute the Depth Paint. 

4-4-1-1: Depth Pens

[ When selected Round Brush Button ] [ When selected Rectangular Button ]

[ Round Brush with sharp edge ] [ Air Brush1 with shaded edge ] [ Air Brush2 with strongly shaded edge ]

Air Brush2Air Brush1Round Brush

Brush size slider: 
You can select Brush Size by this slider.

[ Size=50 ] [ Size=80 ]
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4-4-1-2: Painting Tools

Gain slider: 
You can select the value of Painting Effect by this slider. The
Painting Effect is similar to Transparency of ordinary paint program
and it is defined by the value of 0% to 100%. In case the value is 0,
the effect it is transparent, when it is 50%, half transparency, when it
is 100%, non- transparency. 

[ Gain=50% ] [ Gain=100% ]

Rectangular Drawing Button:

Select this button and drag your mouse to draw a rectangle. You can change the shape by dragging the
resize handles that are shown at the 4 corners of the rectangle. You can also move the rectangle by
dragging the inside of the rectangle.
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Ellipse Drawing Button:

Select this button and drag your mouse to draw an ellipse. You can change the shape by dragging the
resize handles that are shown at the apex of the ellipse. You can also move the ellipse by dragging the
inside of the ellipse.

Polygon Drawing Button:

Select this button and click your mouse to draw a polygon. You can change the shape by dragging the
resize handles that are shown at the vertex of the polygon. You can also move the polygon by dragging
the inside of the polygon.
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Painting or Filling Button:
Select this button to paint or fill the selected shape. In case any figure is drawn inside
the image, entire image is filled.

[ Rectangular filling ] [ Ellipse Filling ] [ Polygon Filling ]

Reset Figure button:
Select this button to reset the currently selected figure.

Edge Width Slider:
You can select the width of the painting edge by this slider.

[ Edge Width=10 ] [ Edge Width=30 ]

[ Gain=50% ] [ Gain=100% ]

Gain Slider:
You can select the value of Painting Effect that is similar to
Transparency. The gain is defined by the value of 0% to 100%. In
case the value is 0, the effect it is transparent, when it is 50%, half
transparency, when it is 100%, non- transparency. 
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4-4-2: Painting Mode

In this Depth Paint Program are prepared 5 painting modes such as Depth Selection Mode, Bumpy
Painting Mode, Smooth Painting Mode, Gradation Mode, Depth Pickup Mode. In addition, each painting
mode has their detail options.

[ Depth Selection Mode ] [ Bumpy Painting Mode ] [ Smooth Painting Mode ]

[ Gradation Mode ] [ Depth Pickup Mode ]

Depth Selection Mode Button:
Select this button to enter the Depth Selection Mode. At the Depth Selection Mode, you
can define an absolute depth of the currently selected Depth Pen.

Bumpy Painting Mode Button:
Select this button to enter the Bumpy Painting Mode. At the Bumpy Painting Mode, the
depth you paint is added plus or minus to the current depth. This Bumpy Painting is useful
if you want a little more or less depth at a certain area to make a bumpy surface.
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Smooth Painting Mode Button:
Select this button to enter the Smooth Painting Mode. At the Smooth Painting Mode, you
can paint a smooth Depth along a border between different surfaces.

Gradation Mode Button:
Select this button to enter the Gradation Mode. It is useful when you paint geographic
objects such as a floor and a tunnel.

Depth Pickup Mode:
Select this button to enter the Depth Pickup Mode. You can pick-up the depth of the cur-
rent position.

4-4-2-1: Depth Selection Mode

Select this mode to define the absolute value of the depth of the currently selected Depth
Pen.

When the Red Color is getting stronger, the painted area comes out
to the foreground as shown in the figure. 

The following options can be used in this Depth Selection Mode.

Depth Value Slider: 
In the Depth Selection Mode, you can use this slider to define the
absolute value of your currently selected Depth Pen.

Depth Pickup Button: 
In the Depth Selection Mode, you can use Depth Picker to pickup the value of the currently
selected point of the image. 

In this picture, the Depth of the Blue area is set as 0 and the Depth of the
Red area is set as 255.
When clicking the mouse at the Red area, the Depth of the currently
selected pen is set as 255.
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Average Depth Pickup Button:
When selecting this button, the shape of the cursor is changed to a syringe-like shape and
you can pickup the average depth of the area that is surrounded by the Round.

In this picture, the depth of Blue area is 0 and the depth of Red area is
255. When clicking your mouse at the position between Red and Blue
area, the depth of currently selected pen is set as the average 70.

Middle Value Pickup Button:
When selecting this button, the shape of the cursor is changed to a syringe-like shape and
you can pickup the middle value of the depth of the area that is surrounded by the circle.

In this picture, the depth of Blue area is 0 and the depth of Red area is
255. When clicking your mouse at the position between Red and Blue
area, the depth of currently selected pen is set as the middle value 127.

Depth Palette:
Use this Depth Palette to setup the absolute depth of the currently selected Depth
Pen. The values of the palette are prepared as 0, 36, 72, 109, 145, 182, 218 and
255 from the top.

4-4-2-2: Bumpy Painting Mode

In this Bumpy Painting Mode, you can select the value of Unevenness by the Unevenness
Slider shown below so that you can make a bumpy surface by adding or subtracting the
value of Unevenness to/from the current surface.

Unevenness Slider:
When the value is minus, the Depth is decreased and when the value is plus, the Depth is increasedas
much as the value of Unevenness.

[ - Unevenness Effect ] [ + Unevenness Effect ]
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4-4-2-3: Smooth Painting Mode

Smooth Painting Mode Button:
Select this button to enter the Smooth Painting Mode. At the Smooth Painting Mode, you
can paint a smooth Depth along a border between different surfaces by using the Average
Depth Pickup Button, and Middle Value Pickup Button.

[ When selected Average Depth Pickup Button ] [ When selected Middle Value Pickup Button ]

Average Smooth Option Button:
When selecting this button, you can pickup the Average Depth of the area that is surround-
ed by the circle.

Middle Value Smooth Option Button:
When selecting this button, you can pickup the Middle value of the depth of the area that is
surrounded by the circle.
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4-4-2-4: Gradation Mode

This Gradation Mode is useful when you give a smooth change of depth to geometric
object such as floor and building. You can use the following options in this mode.

Starting Depth Slider:
By using this slider, you can define the depth of starting point of the
gradation.

Ending Depth Slider:
By using this slider, you can define the depth of ending point of the
gradation.

Plane Gradation Mode Button:
Select this button to enter the Plane Gradation Mode. In this mode, when dragging
your mouse appears an arrow and it defines the starting and ending point of the gra-
dation. When releasing the mouse button, the points are fixed.

Cone Gradation Mode Button:
Select this button to enter the Cone Gradation Mode. In this mode, when dragging
your mouse appear an arrow and a circle and the root of the arrow defines the start-
ing point and the circle line defines the ending point of the gradation. When releasing
the mouse button, the points are fixed.

[ Effect of the Plane Gradation ][ Plane gradation setting by an arrow ]

[ Effect of the Cone Gradation ][ Cone Gradation setting by an arrow and a circle ]

[Note]: Each gradation mode is canceled when newly selected a new mode. Select
the necessary mode button again to define the starting and ending point of the
gradation again.
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4-4-2-5: Automatic Depth Pickup Mode

Enter this mode to make Automatic Depth Paint. In this mode, the depth of each point is
calculated by the value of the original colors of the image. In this StPaint Plus are currently
prepared 2 methods of Automatic Depth Paint as shown below.

Pickup method selection radio button:
By this radio button, you can choose Brightness or Red Color for the
Key to calculate the depth.

Darkest Point Value Slider:
You can define the Depth of the darkest point.

Lightest Point Value Slider: 
You can define the Depth of the lightest point.

Examples of Automatic Depth Paint (In case of using Polygon Shape):

[ Original image ] [ Automatically calculated depth ]

[ Original image ] [ Red component conversion ]

The difference between "Brightness Conversion" and "Red component conversion":

[Note]: In case of underwater pictures, it looses red component with the increase of
distance in general. When using this tendency, you can make a very effective
automatic depth paint by the red component conversion.

[ Brightness conversion ]
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5-1: File Menu

In the File Menu are prepared a couple of basic menus such as New Creation, Open & Close Files, Save
Files, and Print. Tool Bar Icons and Shortcut Keys are also setup for some of the function menus.

5-1-1: New Shortcut Key: Ctrl + N Tool Bar Icon:

Select this menu to execute this Depth Paint newly. When selecting this menu appears a Dialog Box for
selecting an original image file. Select an original 2D image to open the new Depth Paint Window. You
can start Depth Painting in this window, but please note that the selected image keeps its original status
without any affection by the Depth Paint process.

[Note]: Available image file format: JPEG, BMP, TIFF(Non-compression), GIF, PNG.

5-1-2: Open Shortcut Key: Ctrl+O Tool Bar Icon:

Select this menu to open an already existing STP file that is created by the StPaint Plus.

[Note]: STP file is a StPaint Plus original file that contains necessary parameters with respect
to the original image, depth, etc. STP files are expressed by "xxxxxx.stp"

5-1-3: Close

Select this menu to finish a Depth Paint process and to save the STP file by overwriting.

[Note]: This Close menu functions the same as Close Box of the Depth Paint Window.

5-1-4: Save Shortcut key: Ctrl+S Tool Bar Icon:

Select this menu to save a Depth Paint File as a STP file by overwriting. In case you save a STP file for the
first time, you can put the name and location by using the Dialog Box for the file saving. From the second
time, the STP file is automatically overwritten to the previous STP file.

Chapter 5: Menu and Icons
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5-1-5: Save As

Select this menu to save a Depth Paint File as a new STP File putting a new file name.
When selecting this menu appears a Dialog Box for the File Saving. Put the name and location to save the
STP file with this Dialog Box.

5-1-6: Save As L/R/D Separated Files Shortcut key: Shift+Ctrl+Q

You can save currently editing Left and Right and Depth Map images separately.

5-1-7: Save Image File Shortcut key: Shift+Ctrl+M

Select this menu to save a Depth Paint File as a Stereoscopic Image or left & right separate images. You
can select the file format in the Dialog Box for File Saving.

[Note]: Available file format for this Saving Image are JPEG, BMP, TIFF (Non-compression),
GIF, PNG
Regarding the Stereoscopic Format, you can select from the following formats.

1) Anaglyph: Stereoscopic image that can be seen in Gray Scale by using a Red & Cyan glasses.

2) Color Anaglyph: Stereoscopic image that can be seen in Color Scale by using a Red & Cyan
glasses.

3) Parallel side-by-side: A pair of Right & Left images in parallel side-by-side.

4) Cross side-by-side: A pair of Right & Left images in cross side-by-side.

5) Left Image: An image viewed from the left eye.

6) Right Image: An image viewed from the right eye.
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5-1-8: Save JPS Image Shortcut key: Shift+Ctrl+J

Select this menu to save a Depth Paint File as a JPS file that is widely used in many kinds of Stereoscopic
display Systems. The JPS file that is supported by the StPaint Plus is a side-by-side format.

5-1-9: Import Depth File Shortcut key: Shift+Ctrl+I

For a currently editing 2D image, you can import Depth Map image (0-255 gradations). Where, the Depth
Map size and ration must be the same as editing image.

5-1-10: Export Depth File Shortcut key: Shift+Ctrl+E

You can export and save currently editing Depth Map  in gray scale image (0-255 gradations).

[Note]: Available file format for this Saving Image are JPEG, BMP, TIFF (Non-compression),
GIF, PNG
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5-1-11: Print Option

Select this menu to select a Image Format for printing from the various kinds of image format as listed
below.

■ Stereo Mode:
1) Anaglyph: Stereoscopic image that can be seen in Gray Scale by using a Red & Cyan glasses.

2) Color Anaglyph: Stereoscopic image that can be seen in Color Scale by using a Red & Cyan glasses.

3) Parallel side-by-side: A pair of Right & Left images in parallel side-by-side.

4) Cross side-by-side: A pair of Right & Left images in cross side-by-side.

5) Left Image: An image viewed from the left eye.

6) Right Image: An image viewed from the right eye.

[Note]: When selecting the Parallel side-by-side or the Cross side-by-side, a Black Marker is
printed as a standard point of the naked-eyed stereoscopic view.

■ Back Ground Color:
Select this menu to print the background of the image with the selected color such as Black and White,
etc. You can select color by clicking a color listed in the Color Dialog shown below.

■ Margin:

You can setup the margin of Top, Button, Right, and Left.

[Note]: The value of margin should be Integral Number.
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5-1-12: Print Shortcut key: Ctrl+P Tool Bar Icon:

Select this menu to print a Depth Paint Image with a format that is defined by the above Print Options.

5-1-13: Print Preview

Select this menu to preview the result of printing.

5-1-14: Print Setup...

Select this menu to setup necessary parameters for printing such as Paper Size, Paper Direction.

5-1-15: Exit

Select this menu to quit the StPaint Plus and save a Depth Paint Image as a STP file by overwriting.

5-2: Edit Menu

In this Edit Menu are prepared a couple of functions that are related to Drawing and Depth Initialization.
Button Icons and Shortcut keys are also setup for some of those menus.

5-2-1: Undo Shortcut key: Ctrl+Z

Select this menu to get back to one step previous status of the Depth Paint Image.

5-2-2: Painting or Filling Button Icon:

Select this menu to fill inside of a selected figure (Rectangular, Ellipse, Polygon) with a selected Painting
Mode. In case no figure is selected, entire image is filled.

5-2-3: Drawing Tool Reset Button Icon:

Select this menu to reset the currently selected figure(Rectangular, Ellipse, Polygon) and to initialize the
image.

5-2-4: Depth Clear

Select this menu to reset the currently defined depth to 0.
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5-3: Tool Menu

In this Tool Menu are prepared a couple of Painting Tools such as various kinds of Brushes and Painting
Modes as listed below.

5-3-1: Round Brush Button Icon:

Select this menu to use the Round Brush.

5-3-2: Air Brush1 Button Icon:

Select this menu to use the Air Brush1.

5-3-3: Air Brush2 Button Icon:

Select this menu to use the Air Brush2.

5-3-4: Rectangular Button Icon:

Select this menu to draw a Rectangular.

5-3-5: Ellipse Button Icon:

Select this menu to draw an Ellipse.

5-3-6: Polygon Button Icon:

Select this menu to draw a Polygon.

5-4: Drawing Mode Menu

In this Drawing Mode Menu are prepared various kinds of Drawing Modes that are related to the optional
buttons.

5-4-1: Depth Painting Mode Button Icon:

Select this menu to define an absolute value of the depth for Depth Painting.
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5-4-2: Depth Painting Mode Options

Select this Depth Mode Menu to select the Depth Mode options listed below.

■ Depth Pickup Button Icon:

When selecting this menu, the shape of the cursor is changed to that of a syringe and it allows you to pick-
up the depth value of the currently selected point.

■ Depth Pickup(Avarage) Button Icon:

When selecting this menu, the shape of the cursor is changed to that of a syringe and it allows you to pick-
up the average depth value of the currently selected circle.

■ Depth Pickup(Middle) Button Icon:

When selecting this menu, the shape of the cursor is changed to that of a syringe and it allows you to pick-
up the middle depth value of the currently selected circle.

5-4-3: Bumpy Painting Mode Button Icon:

Select this button to enter the Bumpy Painting Mode. At the Bumpy Painting Mode, the depth you paint is
added plus or minus to the current depth. This Bumpy Painting is useful if you want a little more or less
depth at a certain area to make a bumpy surface.

5-4-4: Smooth Painting Mode Button Icon:

Select this button to enter the Smooth Painting Mode. At the Smooth Painting Mode, you can paint a
smooth Depth along a border between different surfaces by using the Average Depth Pickup Button, and
Middle Value Pickup Button.

5-4-5: Smooth Painting Mode Options

Select this button to enter the Smooth Painting Mode. At the Smooth Painting Mode, you can paint a
smooth Depth along a border between different surfaces by using the Average Depth Pickup Button, and
Middle Value Pickup Button.
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■ Average Smooth Option Button Button Icon:

When selecting this button, you can pickup the Average Depth of the area that is surrounded by the circle.

■ Middle Value Smooth Option Button Button Icon:

When selecting this button, you can pickup the Middle value of the depth of the area that is surrounded by
the circle.

5-4-6:  Gradation Mode Button Icon:

This Gradation Mode is useful when you give a smooth change of depth to geometric object such as floor
and building.

5-4-7: Gradation Mode Options

You can use the following options in this mode.

■ Plane Gradation Mode Button Icon:

Select this button to enter the Plane Gradation Mode. In this mode, when dragging your mouse appears an
arrow and it defines the starting and ending point of the gradation. When releasing the mouse button, the
points are fixed.

■ Cone Gradation Mode Button Icon:

Select this button to enter the Cone Gradation Mode. In this mode, when dragging your mouse appear an
arrow and a circle and the root of the arrow defines the starting point and the circle line defines the ending
point of the gradation. When releasing the mouse button, the points are fixed.

■ Back Depth Pickup Button Icon:

Select this menu to pickup the depth value of the selected point and to define it as the starting deepest
point of the gradation. 
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■ Back Depth Pickup(Avarage) Button Icon:

When selecting this button, you can pickup the Average Depth of the area that is surrounded by the circle
and define this value as the depth value of the starting deepest point of the gradation. See 5-4-2.

■ Back Depth Pickup(Middle) Button Icon:

When selecting this button, you can pickup the Middle Depth Value of the area that is surrounded by the
circle and define this value as the depth value of the starting deepest point of the gradation. See 5-4-2.

■ Front Depth Pickup Button Icon:

Select this menu to pickup the depth value of the selected point and to define it as the ending deepest point
of the gradation.

■ Front Depth Pickup(Avarage) Button Icon:

When selecting this button, you can pickup the Average Depth of the area that is surrounded by the circle
and define this value as the depth value of the ending deepest point of the gradation. See 5-4-2.

■ Front Depth Pickup(Middle) Button Icon:

When selecting this button, you can pickup the Middle Depth Value of the area that is surrounded by the
circle and define this value as the depth value of the ending deepest point of the gradation. See 5-4-2.

5-4-8: Automatic Depth Extract Button Icon:

Enter this mode to make Automatic Depth Paint. In this mode, the depth of each point is calculated by the
value of the original colors of the image. In this StPaint Plus are currently prepared 2 methods of
Automatic Depth Paint as shown below.

5-4-9: Depth Extract Mode Options

When selecting the Automatic Depth Extract Mode, it enables you to select the optional functions from the
above optional menu and buttons.
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■ Extract by Brightness Button Icon:

Select this menu to make Automatic Depth Paint by Brightness Conversion.

■ Extract by Red Button Icon:

Select this menu to make Automatic Depth Paint by Red Component Conversion.

■ Dark Depth Pickup Button Icon:

Select this menu to pickup the depth value of the selected point and to define it as darkest point. See 5-4-2.

■ Dark Depth Pickup(Avarage) Button Icon:

When selecting this button, you can pickup the Average Depth of the area that is surrounded by the circle
and define this value as the depth value of the darkest point. See 5-4-2.

■ Dark Depth Pickup(Middle) Button Icon:

When selecting this button, you can pickup the Middle Depth Value of the area that is surrounded by the
circle and define this value as the depth value of the darkest point. See 5-4-2.

■ Bright Depth Pickup Button Icon:

Select this menu to pickup the depth value of the selected point and to define it as brightest point. See 5-4-
2.

■ Bright Depth Pickup(Avarage) Button Icon:

When selecting this button, you can pickup the Average Depth of the area that is surrounded by the circle
and define this value as the depth value of the brightest point. See 5-4-2.

■ Bright Depth Pickup(Middle) Button Icon:

When selecting this button, you can pickup the Middle Depth Value of the area that is surrounded by the
circle and define this value as the depth value of the brightest point. See 5-4-2.
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5-5: View Menu

In this View Menu are prepared a couple of viewing functions such as Application Windows Display,
Enlargement and Reduction, and Stereoscopic Display as listed below. See 4-2 and 4-3.

5-5-1: Left Image Button Icon:

Select this menu to see the Image viewed from the Left Eye.

5-5-2: Front Button Icon:

Select this menu to see the Image viewed from the Front.

5-5-3: Right Image Button Icon:

Select this menu to see the Image viewed from the Right Eye.

5-5-4: Stereo Button Icon:

Select this menu to see the Image in currently selected Stereo Mode.

5-5-5: Depth Button Icon:

Select this menu to see the Depth of the currently selected image in Red and Blue colors.

5-5-6: Auto Scale

Select this menu to resize the currently selected image automatically to the size of the windows. 

5-5-7: Zoom In

Select this menu to enlarge one step the currently selected image in the window.

5-5-8: Zoom Out

Select this menu to reduce one step the currently selected image in the window.



34

Chapter 5: Menu and Icons ■❚❙❘

5-5-9: Full Size(100%)

Select this menu to see the currently selected image in full size (1:1).

5-5-10: Tool Bar

You can switch Display or Non-display of the Tool Bar by this menu. 

5-5-11: Status Bar

You can switch Display or Non-display of the Status Bar by this menu. 

5-5-12: Stereo Mode Setup

When selecting this menu appears a Dialog Box shown below and you can setup the Stereoscopic Display
to use from the following list.

1) Anaglyph: Stereoscopic image that can be seen in Gray Scale by using a Red & Cyan glasses. Any
ordinary color display can be used for the Anaglyph 3D display. 

2) Color Anaglyph: Stereoscopic image that can be seen in Color Scale by using a Red & Cyan glasses.
Any ordinary color display can be used for this Color Anaglyph 3D display. 

3) Sharp G-Shift: Select this menu to use Sharp's naked eye 3D LCD such as 3D Mebius.

4) H-Interleave: Select this menu to use Horizontal Interleaved 3D LCD such as VREX microPol 3D LCD.

5) H-Interleave(Reverse): Select this menu to use Horizontal Interleaved 3D LCD such as VREX
microPol 3D LCD in reverse mode.
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5-6: Stereoscopic Setup Menu

In this Stereoscopic Menu, you can setup a couple of necessary parameters to create  a  Stereoscopic 3D
image properly.

5-6-1: Layer Depth Setup

When selecting this menu appears a Dialog Box shown below and it enables you to setup the following
parameters.

■ Depth of Layer
This is a depth value of the painting layer. When the Depth of Layer is setup as 0, this layer is seen on
the surface of the display. If the value is Plus, the layer looks deeper and when Minus it looks more front.
The Depth of Layer should be between -100 and 1000.

■ Depth Width of Layer
The strength of Stereoscopic View is fixed by the Depth Width of Layer. If it is 0, the image looks flat
regardless the depth change. When it is larger, the stereoscopic effect becomes stronger.

5-6-2: Stereoscopic Vision Parameters

When selecting this menu appears a Dialog Box shown below and it enables you to setup the following
parameters such as the Camera basis. Setup proper parameters based on your 3D display.

■ Viewing distance
You can setup here the distance (mm) between your 3D display and your eyes. 650mm is supposed to
be standard in general. The value should be Integer between 250 and 2000mm.

■ Camera basis
You can setup here the distance (mm) between Right and Left eyes for rendering those Right and Left
images.  65mm is supposed to be standard in general. The value should be Integer between 25 and
500mm.
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5-7: Window Menu

In this Window Menu, you can control the application windows as shown below. The currently opened
window's file names can be shown in the bottom of the menu.

5-7-1: Cascade

Select this menu to display multiple windows in cascade as shown below. 

5-7-2: Tile

Select this menu to display multiple windows in tiling as shown below. 
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5-7-3: Arrange Icons

Select this menu to display multiple windows as Icons that are arranged as shown below. 
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5-8: Help Menu

In this Help Menu are prepared a couple of necessary information such as the program version of the
StPaint Plus and the User Registration as shown below.

5-8-1: About StPaint Plus Tool Bar Icon:

Select this About Menu to check the program version and the personal information that are entered at the
program installation. 

5-8-2: User Registration

When selecting this menu appears a Dialog Box for User's Registration as shown below. Make this User's
Registration as soon as possible so that we may send you necessary information such as program update
and other technical information.
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